
Follow these steps to create a new e-mail address using the domain that you have already
purchased.  

This quick guide applies to both Basic and Enhanced mailboxes and includes steps on:

updating the DNS for your domain to include our e-mail servers so you can start receiving
e-mails
how to access the Webmail from any browser and send your first e-mail
how to request a transfer of your e-mail account (e-mail migration) from the previous
provider
what are the Incoming/ Outgoing Server names and ports
how to set up Autodiscover
how to set up the e-mail account on e-mail clients, such as Mozilla Thunderbird, Outlook,
Apple Mail, and other e-mail applications

DNS Configuration
Webmail client
E-mail Migration
Servers & Ports
Autodiscover
Setup IMAP or POP on other e-mail clients

Setup e-mail on Mozilla Thunderbird
Setup e-mail on Outlook
Setup IMAP e-mail on iOS
Setup IMAP e-mail on Android

1 - Configure a new e-
mail address - Getting
started



The first step in configuring your DNS is updating your MX records.

MX records tell the world which server should receive the e-mails sent to your domain and deliver
them to the specified e-mail provider, straight to your mailbox. You can usually edit the MX records
for your domain from the same Control Panel you use for managing your DNS. You can safely keep
your website hosted with another provider and only use our hosting services for the e-mail.

You should first remove all other MX records and then add the following, with the specified
preference (the Host value is usually '@'):

Type Host* Points to Priority / Preference

MX @ mx.emailarray.com       5

MX @ mx2.emailarray.com      10

 

Example configuration for MX records in GoDaddy DNS:

DNS Configuration

DNS Updates
It might take some time to see the changes in your DNS based on your provider and domain
settings.

 

1. MX Records

Important
It is not recommended to create CNAME records within your domain that point to EmailArray
MX records and use that CNAME as your MX records.



 

To access your webmail using a custom URL, you must configure CNAME records within your
domain for the webmail host.

You must create:

Type HOST Points to Your Webmail URL will be

CNAME webmail webredirect.emailarray.com webmail.yourdomain.com

 

Example configuration for Webmail records in GoDaddy DNS:

 

2. Webmail Record

Don't forget to replace yourdomain.com with the actual name of your domain.

3. SPF Record
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The SPF record is necessary, so your e-mail is not marked as Spam. The SPF will help with your e-
mail deliverability because it specifies a list of authorized hosts that can send e-mails on behalf of a
domain.

First, check for any existing TXT records with SPF.

If you don't have an existing SPF record, you must add a TXT record with the following value (the
host value is usually '@'):

Type HOST TXT Value

TXT @ v=spf1 include:emailarray.com -
all

If you have an SPF record, you should edit it and insert before the final -all directive, the following
value: include:emailarray.com

 

Example configuration for SPF TXT records in GoDaddy DNS:

 

To improve e-mail deliverability, you should enable DKIM for your domain from your Admin Panel
 and then add the records to your DNS.

DKIM is an e-mail authentication method designed to detect forged sender addresses in e-mails, a
technique often used in phishing and e-mail spam (Wikipedia).

To enable DKIM for your domain:

4. DKIM Records
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Go to the Admin Panel.
Log in using your Admin username and password.
Click on Domains in the menu.
Click on the DKIM icon next to the domain you wish to activate DKIM for
In the new window, switch the Enable option to Yes. This will generate your DKIM record.
Update your DNS to include the generated DKIM record as TXT record (use the Host
 value for Host and the Key value for TXT Value).
Note it might take some time to propagate in the DNS.

 

To simplify the configuration on some desktop & mobile e-mail clients, you should use the
Autodiscover web service record to configure these clients automatically. You have to add an *A*
record in the DNS for your domain:

A record hostname Points to

autodiscover.<yourdomain.com> 69.28.212.195

Visit the "Autodiscover" page for more information.

 

5. Autodiscover Records

Example of a Setup in GoDaddy:
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For both Basic and Enhanced mailboxes, our supported Webmail interface is the Group-Office
Webmail. It’s a complete re-design, very modern and fast, and it works as well on mobile as on
the desktop.

The Webmail doesn’t need additional setup, and you can access it from any computer,
smartphone, or tablet without installing other applications.

You can access the Webmail in a few ways:

Option 1: Log in directly to webmail.emailarray.com using your full email address and
password.
Option 2: From your Admin Panel, click on the envelope icon on the Users page. You
can save the link and bookmark it to your favorite Browser for quick use in the
future.

Option 3: adding to your DNS the Webmail record and using this type of URL in the
Browser: webmail.mydomain.com (make sure you replace mydomain.com with your
domain name). This works only if you have set up the DNS records for the

Webmail.

     

You need to configure or modify your DNS by pointing ‘webmail.yourdomain.com’ to 
webredirect.emailarray.com via a CNAME record.

Webmail client

How to access your Webmail

How to Switch to the New Webmail?
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You would then access your Webmail by visiting http://webmail.yourdomain.com. Use the HTTP
protocol, and it will be automatically redirected to HTTPS. 

To ensure the proper migration of all your data from your existing accounts, you must open a
support ticket requesting a migration to the new Webmail.

Existing Enhanced Accounts - How to Migrate to
the new Webmail?

http://webmail.yourdomain.com/


If you need to migrate mailboxes from a previous provider, first create the mailboxes on our side
and then send an e-mail to Support (or open a ticket) to request a migration.

You can also schedule a migration during your out-of-office hours - send the request at least 24
hours before the wanted time frame (and at least 48 hours before a weekend migration).

1. Create the mailboxes on our side from your Administrator Panel or WHMCS. 
2. Collect the necessary info from the existing e-mail service: IMAP server address,

current passwords of each e-mail address (check if you can set up temporary ones just for
the migration).

3. Send your migration request by e-mailing Support with the following information:
the e-mail address
the password for the e-mail address with the previous provider
source IMAP server address of the previous provider
Please make sure you have the correct passwords for each e-mail address.

4. For migration of multiple mailboxes, you can attach a CSV file with these details. Click
here to download an example CSV file.

5. Our team supervises the migration and will update the ticket once it has been completed.
The migration duration depends on the mailboxes' total size, the original mail server's
speed, and the already scheduled migrations - but it's usually completed in less than 24
hours.

6. Update the DNS records (MX, SPF, DKIM, webmail, etc.) for the domains to point to our
servers ( use the information in this guide: DNS Configuration).

7. Our team does another sync to make sure we transferred everything.
8. Setup your e-mail clients to use the new IMAP and SMTP hostnames. You can use the

information in this guide: Servers & Ports.

We do a two-step migration: before and after changing the MX records to make sure everything is
transferred over.

We can also import your Contacts and Calendar. To request this kind of migration, attach the
exported *.vcf files (for Contacts) and the *.ics files (for Calendar) in the Support ticket.

E-mail Migration

How to Request an Email Migration

Contact and Calendar Migration

https://support.emailarray.com/
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Configuring "[Support:Autodiscover & Autoconfig]" can simplify the configuration of your desktop clients

Encryption Server Address Ports

SSL imap.emailarray.com 993

TLS imap.emailarray.com 143

NONE imap.emailarray.com 143

 

Encryption Server Address Ports

SSL smtp.emailarray.com 465

TLS smtp.emailarray.com 25,26,587

NONE smtp.emailarray.com 25,26,587

Important
You must enable SMTP Authentication in your e-mail client in order to send e-mails out.

Also note that IMAP is recommended rather than POP, as it´s a protocol made to support several devices accessing
one same account, with all folders synced at our server, which also guarantees that our backups will be executed.

Encryption Server Address Ports

Servers & Ports

Servers & Ports

IMAP Service

SMTP Service

 

POP3 Service



SSL pop.emailarray.com 995

TLS pop.emailarray.com 110

NONE pop.emailarray.com 110



 

It's a web services that is used by a growing number of applications and which helps in configuring
your mobile devices and desktop clients. Autodiscover is used by Outlook, Thunderbird, eM Client,
iOS & Android devices in order to automatically configure the e-mail application.

This services allow you to configure an e-mail account by only entering your e-mail address and
password, without having to worry about incoming servers, outgoing servers, or ports. All
communication is configured to be secured through SSL by default. However, the implementation is
heavily dependent on the software maker ( Apple, Microsoft ) and some versions have better
integrations than others.

You'll need to add an A type record in the DNS of the domain for which you'd like to enable this
services:

A record hostname Points to

autodiscover.<yourdomain.com> 69.28.212.195

Autodiscover
Autodiscover for Outlook, Thunderbird & Mobile
Devices

What is Autodiscover ?

 

DNS Configuration



These tutorials will help you add your mailbox as an IMAP or POP account in various e-mail clients,
including Thunderbird, Outlook, Android and iOS. Most e-mail clients will require a manual setup.

If you are familiar with this setup, you can go to Servers and Ports wiki page.

For the SMTP settings, remember to always mark the option to "Require authentication"
(sometimes referred to as "My server requires SMTP authentication").

Also note that IMAP is recommended rather than POP, as it´s a protocol made to support several
devices accessing one same account, with all folders synced at our server, which also guarantees
that our backups will be executed.

Setup IMAP or POP on other e-
mail clients

https://wiki.emailarray.com/display/Support/Setup+e-mail+on+Mozilla+Thunderbird
https://wiki.emailarray.com/display/Support/Setup+e-mail+on+Outlook
https://wiki.emailarray.com/display/Support/Setup+IMAP+e-mail+on+Android
https://wiki.emailarray.com/display/Support/Setup+IMAP+e-mail+on+iOS


Setup IMAP or POP on other e-mail clients

You can ask your sysadmin to setup Autoconfig in your DNS to make the process of setting up Thunderbird
much easier.

To open the setup window for a new email account, you have multiple options:

Click on Tools -> Account Settings -> Account Actions -> Add Mail Account.
If your menus on the top are hidden, click on the ALT key to show them, or access 
Account Settings by clicking on the radiator icon, on the top right of the interface, then 
Options -> Account Setting -> Account Actions -> Add Mail Account.
Click the menu icon → New → Existing Mail Account.

The Set Up Your Existing Email Address window will show.

 

Enter the user's display name, full e-mail address and password:

Setup e-mail on Mozilla
Thunderbird

Step 1

Step 2

https://wikidev.emailarray.com/books/1-configure-a-new-e-mail-address-getting-started/page/autodiscover-clI


 

Click on Continue. Thunderbird will automatically find the proper server names if you have set the
Autoconfig record in your DNS.

 

If Thunderbird doesn't automatically find the server names, please use the details from the Server
& Ports page.

Step 3
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Click on Done to finish the account setup. Wait for Thunderbird to synchronize the data.

Note that Thunderbird will automatically setup the account as IMAP. If you want to set up the account as POP, you have
to setup the account manually. IMAP is recommended, as it´s a protocol made to support several devices accessing one
same account, with all folders synced at our server, which also guarantees that our backups will be executed.

Step 4

https://wikidev.emailarray.com/uploads/images/gallery/2024-08/thunderbird-email-config-3-after-re-test.PNG


Setup IMAP or POP on other e-mail clients

Below, step by step tutorials according to the Outlook version used, which you can usually check
when opening Outlook or in the Help menu/About. There's also a website with a generic Outlook
setup which can be useful, so you can view screenshots.

Also notice that if this is the first time you open Outlook since its installation, a window will
immediately pop up asking you to set up your email account. Click yes and proceed and follow our
instructions starting with a section in which you start typing in your account data.

Finally, as per our tests, sent items and trash are automatically saved in IMAP folders, except in
older Outlook 2003. Nonetheless, information about this is available for Sent Items and Trash,
especially useful if your Outlook is not in English and you want to manually define folders used for
these base folders. Notice that our Webmail automatically decodes the English default names
(Sent, Trash, Drafts, Spam) so that it shows them in the language in which you accessed Webmail.
In some cases, however, it might be required to change folder mappings in Webmail, if Outlook
does not do this conversion automatically, besides mapping the localized names in your Outlook.

Depending on the size of your mailbox and your Internet speed, Outlook might take from a few hours to a few days to
synchronize the mailbox and build the local PST file.

Note that Outlook will automatically set up the account as IMAP. If you want to set up the account as POP, you have to
set up the account manually. IMAP is recommended, as it´s a protocol made to support several devices accessing one
same account, with all folders synced at our server, which also guarantees that our backups will be executed.

Unfortunately, this version of Outlook doesn't support Autodiscover for IMAP accounts anymore.

Click on the File menu 
Click on + Add Account

Setup e-mail on Outlook

Outlook 365

http://www.setup-outlook.com/
http://www.setup-outlook.com/
http://www.msoutlook.info/question/486
https://community.homestead.com/homestead/topics/when_i_delete_an_email_in_outlook_it_puts_a_line_strikethrough_through_the_text_and_it_wont_delete_the


          

Fill in your full email address and select the option Let me set up my account
manually.
Click on Next.
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Select IMAP from the list of account types.

     

Fill in server information from the Server & Ports page
Click on Next

     

Fill in your existing password for your email address and click on Connect
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The setup is completed. The message Account successfully added will show and
Outlook will begin synchronizing the account.

Depending on the size of your mailbox and your Internet speed, Outlook might take from a few
hours to a few days to synchronize the mailbox and build the local PST file.

Click on the File menu 
Click on + Add Account

     

Outlook 2013/2010:
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Select POP or IMAP

     

Option 1: this version of Outlook supports Autodiscover for IMAP accounts if you have 
setup Autodicover in your DNS.

Type in your full name, e-mail address, and password and click on Next
Click on Allow when asked about autodiscover.xml
Click on Finish

Option 2: If you don't have Autodicover
select Manual setup and click on Next.

            

Type in your full name, e-mail address, and password
Fill in server information from the Server & Ports page              
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Click on More Settings.
Select My outgoing server (SMTP) requires authentication and Use same
settings as my incoming mail server.

               

Click on the Advanced tab
Verify the ports are correct and SSL is selected.

https://wikidev.emailarray.com/uploads/images/gallery/2024-08/add-email-address-to-an-email-client-outlook-2013-4-selected.jpg
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Click on OK. Click on Next to finish the setup.

Depending on the size of your mailbox and your Internet speed, Outlook might take from a few hours to a few days to
synchronize the mailbox and build the local PST file.

https://wikidev.emailarray.com/uploads/images/gallery/2024-08/add-email-address-to-an-email-client-outlook-2013-6-options.jpg


Setup IMAP or POP on other e-mail clients

If you have an Enhanced mailbox, you can use ActiveSync, to not only sync e-mails, but also contacts and calendars.

You can log in to the Webmail and download a profile to automatically setup the e-mail as IMAP.
The profile will include calendars and contacts if you have an Enhanced mailbox.

Here's the step by step for setting up an IMAP account on iOS.

Click on Settings
Click on Mail, Contacts, Calendars
Click on Add Account
Click on Other
Click on Add Mail Account
Inform the following

Name - The display name you want on your outgoing email
Email - Your full email address
Password - Your email password
Description - A description for your account

Click on Next
IMAP is selected by default
Under Incoming Mail Server, enter as below:

Host Name - imap.emailarray.com
User Name - Your full e-mail address
Password - Your password

Setup IMAP e-mail on iOS
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Under Outgoing Mail Server, enter as below:
Host Name - smtp.emailarray.com
User Name - Your full e-mail address
Password - Your password

Click on Next
Click on Save

Note that IMAP is preferred over POP. If you want to set up the account as POP, you have to
set it up manually. IMAP is a protocol made to support several devices accessing one same
account, with all folders synced at our server, which also guarantees that our backups will
be executed.

Example setup for iOS:
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Setup IMAP or POP on other e-mail clients

Remember that, if you have an Enhanced account, you can use ActiveSync, to not only sync e-
mails, but also contacts and events.

Here's the step by step for setting up an IMAP account on Android's native mail app.

Press the device's Menu button.
Tap Settings.
Go to Manage Accounts
Click on Add account.
Click on Email / Personal (IMAP)
Username: enter your full e-mail address
If an account type is asked, choose IMAP account.
Password: enter your email's password.
Incoming server settings

Username: your full email address
Password: your email's password
Server:  imap.emailarray.com  . Android will automatically use yourdomain.com as host
and you need to change it.

Outgoing server settings
Require signin: YES
Username: your full email address
Password: your email's password
SMTP server: smtp.emailarray.com  . Android will automatically use yourdomain.com
as host and you need to change it.

Account options: Optionally, you can set up specific details such as interval for checking
mail, if you want to be notified, etc.
On the last page, Android gives you the option to change the Account name (will appear in
your list) and Your name (will appear to recipients).
Click on Next to finalize the procedure.

 

Note that IMAP is preferred over POP. If you want to set up the account as POP, you have to set it up manually. IMAP is a
protocol made to support several devices accessing one same account, with all folders synced at our server, which also
guarantees that our backups will be executed.

Setup IMAP e-mail on Android

How to set up your email on an Android device



 

Example Setup on Android Mail App
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